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1Chapter 1 Welcome

1Welcome

Thank you for choosing Karaoke CD+G Creator from Doblon.

Karaoke CD+G Creator is a CD+G Karaoke authoring tool. It allows to create a CD+G song from scratch
or allows to import MIDI Karaoke (KAR) files.

Tutorials

Create CD+G song with PowerWizard

Import an existing CD+G file and create your own version of the song

Create CD+G song from MIDI karaoke

Create song with duets (Pro version only)

Getting started

The user interface
Entering lyrics
Working with soundtracks
Synchronizing lyrics
Creating CD+G files
What's new

Getting results

Removing vocals
Creating duets
Using CD+G events
Images
Searching for MIDI Karaoke on the web
Batch file create
Batch MIDI import
Advanced lyrics import
Exporting lyrics

Command Reference

 Differences between Pro and regular versions
Unlocking and evaluating

Step-by-step tutorials will guide through various tasks in Karaoke CD+G Creator:
Create CD+G song with PowerWizard

Import an existing CD+G file and create your own version of the song

Create CD+G song from MIDI karaoke
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Create song with duets (Pro version only)

Create CD+G song with PowerWizard

PowerWizard will help you to create your first CD+G karaoke song with Karaoke CD+G Creator.

The song we will create is Nobody knows you when you're down and out by Jimmy Cox, made famous by
Eric Clapton.

Starting PowerWizard

To start PowerWizard click Create New Song Wizard toolbar button ( ). PowerWizard dialog box will
appear.

There are two automated paths that can be used with PowerWizard. The first is creating a new karaoke
song from lyrics and soundtrack (this is what we are goint to do now). The other one is MIDI karaoke
import.

By default PowerWizard is configured to run when Karaoke CD+G Creator starts. You can modify this
setting with Run this wizard on program startup checkbox.

To proceed to the next step click Next button.

Soundtrack

The next step will be choosing the soundtrack to use for the song.
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To load the soundtrack click Browse button and navigate to the following file:

C:\Program Files\Doblon\Karaoke CD+G Creator\Examples\nobody knows you.mp3 

or 

Documents\My Karaoke\Karaoke CD+G Creator Pro Examples\nobody knows you.mp3 on Windows Vista.

After the file is loaded its name and playback time will displayed in the wizard window. Karaoke CD+G
Creator can use WAV and MP3 files as soundtracks. The soundtrack file needs to be of CD quality (44
kHz stereo).

PowerWizard allows to remove vocals from the song. Our song is an instrumental track, it does not
contain vocals, so we will not use Power Vocal Remover. More information on removing vocals can be
found in Removing vocals section.

To proceed to the next step click Next button.

Lyrics

Now it is time to provide lyrics for the song.
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There are several ways to add lyrics to the song. You may:
· type lyrics in (you may listen to the song as you type -- use Play button to control the playback)

· use web search for lyrics; Karaoke CD+G Creator automatically opens browser window and runs
search using provided details (song title and artist name); more on lyrics search can be found in
section Search for lyrics on the web

· paste lyrics from the clipboard (you may select the lyrics in web browser or text editor, copy it, and
then paste it into Karaoke CD+G Creator)

· import lyrics from the text file
In this tutorial we will import the lyrics from the text file. Click Import lyrics from TXT file and open the
following file:

C:\Program Files\Doblon\Karaoke CD+G Creator\Examples\nobody knows you.txt

or

Documents\My Karaoke\Karaoke CD+G Creator Pro Examples\nobody knows you.txt on Windows Vista.

The lyrics will be displayed -- you may edit them if necessary.

To proceed to the next step click Next button.

Synchronizing lyrics

This step is the most difficult in the whole process of karaoke song creation. You have to synchronize the
lyrics to the music.
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During synchronization process Karaoke CD+G Creator highlights words one by one, and your task is to
tap the space bar at the moment the word is sung. It is not simple and takes some experience to achieve.
To start synchronizing press Start synchronizing button. The first word in the song will become
highlighted and the song will start to play.
When the song reaches the highlighted word, press Space key on your keyboard. The highlighting will
move to the next word and so on. To mark the end of the word (usually before the long instrumental break)
press Ctrl key. When you are done (ie. all words have been synchronized press Enter key or click Done
button).
Now you need to check how good job have you done. To do this click Test button and see if the words
highlight correctly during playback. Please note that if you have not done perfect job you may adjust
synchronization later (see Adjusting synchronization section).

As you have probably noticed synchronizing lyrics is not an easy task. Here are hints that can make your
life easier:

· use speed control to decrease the playback speed; if you select 0.5 the playback will be two times
slower

· use Go Back button if you miss the beat; Rewind buttons rewinds the playback, but does not move
highlighting

· if you are working on a new song, synchronize it from start till end, and then do it once more; second
pass will be much better

· see Advanced synchronization for for synchronization tips

To proceed to the next step click Next button.

Wizard is done

The wizard is complete -- most of the work is done.
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You are left with three choices now. You may:

· Apply a visual style to the song -- this button will open Styles dialog that will allow you to use
one of song templates

· Adjust synchronization or edit the song -- choosing this option will let you to fine tune the song,
edit lyrics, or fix synchronization errors

· Create CD+G file will take you directly to CD+G file creation

To continue with this tutorial click Adjust synchronization or edit song button.

If Save the song before continuing is checked, you will be prompted to save the song. Karaoke CD+G
Creator saves song in PK2 files. Note that saving files is disabled in demo mode.

Karaoke CD+G Creator main window

Now it is a good time to learn about the main window of Karaoke CD+G Creator.
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On the top you see common Windows interface items -- menu bar and toolbar.

Left side of the window is occupied by the soundtrack panel. It displays a waveform of the current
soundtrack, and on top of it labels that correspond to the synchronized words. More information on using it
can be found in Using the soundtrack panel section.

Right side of the window contains the shortcut bar. It contains shortcuts to most frequently used
commands. Shortcut bar changes with context -- if you do not need it any more you may close (to display
it again use Shortcut bar command from View menu). To leave the shortcut bar visible, but to disable
animations, select Preferences from File menu and uncheck Animate shortcut bar option.
The main area of the screen is taken by the lyrics editor. It consists of two parts -- preview window on the

top (you may close is with Preview toolbar button ) and lyrics area below. 

Preview window displays the CD+G preview of the current part of the lyrics -- this is how your song will
look on the TV screen. If your computer is slow, rendering preview make take a long time and your work
will be uncomfortable. To avoid this either hide the preview window or disable automatic updates (clicking
Update button will render the preview at the current cursor position).

Lyrics area allows to edit the lyrics text, insert CD+G events, and adjust synchronization of the words.

Styles

Now it would be a good time to make our song look better. We will do this using style templates.

To apply a predefined visual style to your song click Styles button on the toolbar ( ) or select Styles
command from Create menu.
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Song details section of the dialog box allows you to enter title of the song, artist name, and text that will
be displayed as your company information (probably something like Presented to you by DOBLON).
Credits are displayed after the song is finished.

Tip: To force a new line in Title, Artist, or Company name fields, use ^ character.

What is style?

Karaoke CD+G Creator allows to set styles for:
· Title: image displayed before the song

· Credits: image displayed after the song is finished

· Song: colors, text formatting, page layout, and image (in Pro version only) of the lyrics

Each of this styles can be applied individually, or it is possible to use presets.

Style preset combo box allows to select one of predefined templates. It will change all styles in Applied
styles. You may store your combination of Title, Song, and Credit styles using Add button. To save
changed combination use Save button. Delete button removes your preset from the list.

Applied styles lists styles used for each of the sections of the song. To change the style select it in
Applied styles list and then choose the new style from Available styles combo. Selecting (Unused) will
disable the style.

Style editor button starts Style Editor dialog box which allows you to create your own styles.

Preview window displays the preview of the style selected in Applied styles list.
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Selected styles will be applied to the song when you select OK button.

To continue with the tutorial select Rock style preset and click OK button.

Adjust CD+G Parameters

Usually you will want to adjust CD+G parameters to your liking. To open CD+G Settings dialog box click

CD+G Settings button on the toolbar ( ) or select CD+G Settings command from Create menu.

Try changing the font and click Apply button. In the preview window of lyrics editor you will see the result
of the changes you have made (you may have to move CD+G Settings dialog to show preview window
beneath it).

To learn more about CD+G Settings dialog box see Modifying CD+G settings section.

When you are satisfied with the way text looks click OK.

Create CD+G File

Now we are ready to create CD+G file.

Click Create CD+G File button on the toolbar ( ) or select Create CD+G File command from Create
menu. You may also press F2 key on the keyboard.
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If you want to write this track to a CD, you need to select BIN as the output type. Selecting CDG output
type will allow you to preview the result in Power CD+G Player. By default the output file is created in the
same directory as the soundtrack file. Make sure that you have all necessary user privileges, or change
the output file location. 

Please note that most of the settings is the same as those in CD+G Settings dialog box.

If you would like to preview the output file, make sure that Open in Power CD+G Player when done
option is checked. You may select a different software CD+G player if you have one -- use Choose
player button to do this.

Tip: If Power CD+G Player Pro is installed on your computer, you will be prompted to use it as a
default CD+G player in Karaoke CD+G Creator. 
Click here to visit Power CD+G Player Pro website.

Now click OK to create CD+G file.

Play CD+G song with Power CD+G Player

Power CD+G Player can be used to play the tracks you create with Karaoke CD+G Creator.

http://www.powerkaraoke.com/src/prod_powercdgplayerpro.php
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It is a good idea to view the song in full before burning it to the CD.

Burn CD+G disc

Karaoke CD+G Creator does not burn CD+G discs. To do this you need Power CD+G Burner. To learn
move visit Power CD+G Burner website.

Import an existing CD+G file

One of the most exciting features of Karaoke CD+G Creator is an ability to import existing CD+G songs.
This allows to re-edit commercial editions of karaoke songs with endless possibilities -- use this to change
font and images, fix broken characters, change lyrics or create parodies. Karaoke CD+G Creator imports
both lyrics and synchronization, so the most cumbersome part of the song creation is already done,
leaving you all the fun.

To import CD+G song select Import CD+G File command from File menu or click Import CD+G File
button on the toolbar.

First you need to select file containing CD+G songs. Two file formats are supported -- CDG BIN file. If you
use CDG file, Karaoke CD+G Creator will automatically look for MP3 file of the same name and use it as a
soundtrack.

If Insert 'Clear Screen' events automatically is checked, Karaoke CD+G Creator will detect when
entire screen is erased in CD+G song and will insert 'Clear Screen' events at the same places in the
imported song. This help to maintain the text flow for page-by-page songs (SoundChoice songs give very
good results with this option enabled).

Import process takes a while (up to half a minute on a slower computer). Once it is completed you will see
the imported lyrics in the lyrics editor. Please check for spelling mistakes, as some of the characters may
be recognized incorrectly.

NOTE:
1. Not every song can be imported. Duets are not supported, also songs using scrolling will not
import.
2. Optical character recognition (OCR) is not perfect and may sometimes make an error. Please
check the lyrics for spelling mistakes.

http://www.powerkaraoke.com/src/prod_powercdgburner.php
http://www.powerkaraoke.com/src/prod_powercdgburner.php
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Import MIDI karaoke

MIDI files are ideally suited for karaoke -- they do not contain vocals, and they can be easily found on the
internet. And a lot of them contain synchronized lyrics. The most common file extension for MIDI Karaoke
files is KAR, but many MID files also contain lyrics.

Karaoke CD+G Creator has Import MIDI Karaoke Wizard that will assist you in process of converting MIDI
karaoke to CD+G.

To start Import MIDI Karaoke Wizard click Import MIDI Karaoke Wizard toolbar button ( ) or select
Import MIDI Karaoke Wizard command from File menu.

Select files

You have to provide the input KAR file -- use [...] button next to input file to locate the file you would like to
convert.

Karaoke CD+G Creator can help you to find MIDI Karaoke songs on the Internet -- click Search the web
for MIDI karaoke songs button. You can learn more about searching for MIDI karaoke on the web in
Search for MIDI karaoke on the web section.

Karaoke CD+G Creator need to record MIDI as WAV file. By default this file will be created in the same
directory as the source KAR file. Use [...] next to output file to modify this directory if necessary.

When you have selected the source KAR file click Next button.

Rendering

Karaoke CD+G Creator need to record MIDI output as WAV input.
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Karaoke CD+G Creator will start MIDI file playback. If everything is configured correctly you should hear
the music and see green and red bar moving in Recording level control.

Some soundcards do not expose appropriate inputs to Karaoke CD+G Creator. If sliders are grayed out
and Recording level control does not display anything you need to adjust MIDI recording input manually.
To do this click Open mixer button. Windows sound mixer will appear.

First you will have to modify playback settings. Note that the title says Play Control. Make sure that MIDI is
not muted.

Now it is time to modify recording settings. To do this select Properties command from Options menu.

Properties dialog box will appear.
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Under Adjust volume for change mode from Playback to Recording. Make sure that MIDI input is
selected in Show the following volume controls list. Click OK to return to Recording Properties.

Now make sure that MIDI is selected as an active input and return to Karaoke CD+G Creator. Recording
level control in Import MIDI Karaoke Wizard should become active.

Unfortunately some soundcards do not allow MIDI to WAV recording. If you are unable to enable MIDI
recording you might try to connect the output of the soundcard to the input with a piece of wire (usually two
mini-jacks wire should do). It should not degrade the sound too much. You may also try to use software
MIDI synthesizer. In case of doubt please contact Karaoke CD+G Creator support.

When everything is set up correctly click Finish.

Recording

Karaoke CD+G Creator now records MIDI to WAV file. It will take exactly the same time as needed to play
the MIDI file.

http://www.harmony-central.com/Software/Windows/software_synthesizers.html
http://www.harmony-central.com/Software/Windows/software_synthesizers.html
mailto:support@powerkaraoke.com
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Lyrics import 

After importing audio it is time to import lyrics. Karaoke CD+G Creator will do this automatically. If there
are any problems with import you will be displayed an appropriate message.

Done

You have successfully imported MIDI karaoke file. You have soundtrack and synchronized lyrics, so you
may follow next steps as described in Create CD+G Song tutorial.

Create song with duets

 Note: This tutorial refers to Pro version only.

Karaoke CD+G Creator Pro gives you the tools to create professional duets. Most important duet features
are:

· Duet Wizard that helps to assign lyrics to singers

· Full Duet synchronization mode

· Divided CD+G screen for duets (Singer 1 at top and Singer 2 at the bottom of the screen)

In this tutorial we will show you how to create a song that can be sing by two singers, each of them
singing different words at the same time.

To understand this tutorial you need to be familiar with creating songs with Karaoke CD+G Creator, so if
you are just starting please see Create CD+G song with PowerWizard tutorial first.

Starting up

In this tutorial we will use a traditional song Brother John. Soundtrack and lyrics can be found in
Examples subdirectory of Karaoke CD+G Creator directory (usually C:\Program
Files\Doblon\Karaoke CD+G Creator Pro or Documents\My Karaoke\Karaoke CD+G Creator Pro

Examples on Windows Vista.). Please create a new song by clicking on New button on the toolbar ( )
or selecting New command from File menu. If you are using PowerWizard, select Create a new song
from scratch (without PowerWizard) on the first wizard screen.

Now load the soundtrack using Load soundtrack button on the toolbar ( ). The soundtrack file is

brother john.mp3. Then load the lyrics from the text file -- use Import lyrics toolbar button ( ) or
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Import lyrics from a text file command from File menu. Lyrics file is brother john.txt. You may save
the first version of the song at this point.

Defining duets

The next step it to assign portions of the lyrics to each of the singers. As you have probably noticed the
song lyrics consists of 5 repeated verses, while the music contains the same verse 4 times only. We will
start with both singers singing the first verse together, then Singer 1 will sing two verses with Singer 2
joining in, but half of the verse later. And the last verse will be sung together by both.

To assign lyrics to singers we will use Duet Wizard. To start it click Duet Wizard button on the toolbar (

) or select Duet Wizard from Edit menu.
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To assign a part of the lyrics to particular singer (or to both singers) select this part in the lyrics window
(drag mouse to select the text) and then click Selection button next to the singer mode you want to use.
Duet Wizard always uses full lines, so if you position the cursor in the middle of the line and then click
Selection, entire line will be assigned.

Lyrics assigned to Singer 1 are red, lyrics assigned to Singer 2 are blue, and those that should be sung
together are grey.

To continue with this tutorial please assign first verse to Both singers, two next to Singer 1, fourth to
Singer 2, and the last one to Both singers again. If you are having problems with this you may close
Duet Wizard with OK, open brother john 2.pk2 file from Examples directory, and select Duet Wizard
again to see how the lyrics should be colored.

After you close Duet Wizard with OK you will see that Duet events have been inserted in the text of the
song.

Each of these events represent the change of the singer -- all text after 'Duet:Singer 1' is assigned to
Singer 1, until another Duet event is reached. If you position the cursor behind the first duet event you will
see that text for Singer 1 is painted in blue.

Synchronization

Now it is time to synchronize the lyrics. To do this we need to enter full duet mode. To do this click Full

duet mode button on the toolbar ( ) or select Enable full duet mode from Synchronize menu. Duet
tab control will appear above the lyrics editor.
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Duet tabs allow switching between duet modes. No duets is for editing lyrics -- it displays the entire text of
the song. The other three are for each of the duet roles.

Selecting Singer 1 tab will activate Singer 1 duet mode. It will dim the lyrics that are not assigned for
Singer 1 and preview will show Singer 1 lyrics only.

Duet tabs are used to synchronize the duet song. Unfortunately synchronizing duet songs takes three
times as long as regular songs -- you have to synchronize part for both singers, and then individual parts
for each of the two singers.

To continue with the tutorial try synchronizing the lyrics with the music. Select Both duet tab, click
Synchronize entire song button on the toolbar, and synchronize the first and the last verse of the song.
Then select Singer 1 tab, click Synchronize entire song button again and synchronize the second and
the third verse. And finally synchronize Singer 2 -- this time start in the middle of the second verse.

You may also load already synchronized song from brother john 3.pk2 file.

Please note that synchronization labels in the soundtrack panel are not visible in No duets mode -- you
need to activate one of the duet tabs to display and edit them.

Settings

Now we may adjust the settings for duets. To do this double click any of the duet events (Duet dialog box
will appear) and select Duet settings button to open Duet settings dialog box. Here you can define the
text settings for Singer 1 and Singer 2 -- just select the mode on the top and adjust the settings. Please
note that the number of lines apply to half of the screen only (Singer 1 uses the upper part and Singer 2
uses the lower part of TV screen). Settings for Both singers mode are copied from general CD+G
settings.

Create file

We are nearly done. All that is left is to create a CD+G file and to see if everything plays correctly. This is
important, as sometimes, because of synchronization errors, some text may overlap.

To create a CDG file click Create CD+G File toolbar button ( ). You may leave all settings at default
values -- simply click OK and see the result.

If you have missed any of the steps you may load the final file -- it is brother john4.pk2.
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Duets without screen split

If you do not wish to split the screen between two singers and rather have words for both singers
displayed one after another, disable Full duet mode before creating CD+G file. Also the lyrics for both
singers should interleave -- they need to be in the same order as they should be displayed (so in general
this will be like duets in PowerKaraoke, but with concurrent highlighting.

We have prepared an example that shows this -- it is brother john no split.pk2 file.

The user interface
Entering lyrics
Working with soundtracks
Synchronizing lyrics
Creating CD+G files
What's new

User interface

Main window
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On the top you see common Windows interface items -- menu bar and toolbar.

Left side of the window is occupied by the soundtrack panel. It displays a waveform of the current
soundtrack, and on top of it labels that correspond to the synchronized words. More information on using it
can be found in Using the soundtrack panel section.

Right side of the window contains the shortcut bar. It contains shortcuts to most frequently used
commands. Shortcut bar changes with context -- if you do not need it any more you may close (to display
it again use Shortcut bar command from View menu). To leave the shortcut bar visible, but to disable
animations, select Preferences from File menu and uncheck Animate shortcut bar option.
The main area of the screen is taken by the lyrics editor. It consists of two parts -- preview window on the

top (you may close is with Preview toolbar button ) and lyrics area below. 

Preview window displays the CD+G preview of the current part of the lyrics -- this is how your song will
look on the TV screen. If your computer is slow, rendering preview make take a long time and your work
will be uncomfortable. To avoid this either hide the preview window or disable automatic updates (clicking
Update button will render the preview at the current cursor position).

Lyrics area allows to edit the lyrics text, insert CD+G events, and adjust synchronization of the words.

Soundtrack panel

Soundtrack panel contains a waveform view of the soundtrack and on top of it displays synchronized
lyrics labels.
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File details

Top of the soundtrack panel contains the name and the length of the current soundtrack file. Also current
cursor position and zoom are displayed.

Zoom

Zoom corresponds to the number of samples shown by one pixel. Zoom 1000 means that every pixel on
the waveform display represents 1000 samples. Karaoke soundtracks have frequency of 44100 samples
per second, so at zoom 1000 44 pixels represent one second of music.
Use the arrows to modify the zoom. Higher values will show more of the screen on the file, increasing the
density. Lower values will give more detail.
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Preview bar

Preview bar is displayed on the left. It represents an entire file. The current part of the soundtrack is
represented by a window on the preview bar.
Click anywhere in the preview bar to position the cursor.
Use arrows to move back and forth in the soundtrack.
You may extend the visible window by dragging its edges (see image above). It has the same result as
changing zoom value.
Click at the bottom of the visible window and drag it to move the window.

Cursor

The horizontal yellow line is a cursor. It represents current position in the file. When you play the music the
cursor will move. Click anywhere on the waveform or on the preview bar to move the cursor to the new
location.

Labels

Labels are synchronized words. The horizontal red lines are start and end points. Label is attached to the
start point.
Soundtrack panel can be used to adjust the start and the end of the word. This can be done in many
ways.

To move the entire word click on the label and move it up and down. The word's duration will
not be changed. The duration of the previous and the next word will be modified
accordingly. You may not move the word earlier then the start of the previous word, and
later than the end of the next word.

In this example you see mouse pointer on label 'good'.

To move the end of the word and the beginning of the next word position click and drag
the word boundary (the red horizontal line).

In this example end of word 'a' and start of word 'good' would be adjusted.

To move the start/end of the word without moving the end of the previous/next word hold
down the SHIFT, and then click and drag the word boundary.

Only the beginning of the word 'good' would be moved.



23Chapter 3 Getting started

3Getting started

Only the end of the word 'good' would be moved.

To place a cursor over the label boundary keep the CTRL key down and click as if label was
not there.

Shortcut bar

Shortcut bar contains shortcuts to most frequently used commands of Karaoke CD+G Creator. Shortcut
bar changes with context -- if you do not need it any more you may close (to display it again use Shortcut
bar command from View menu). Shortcut bar is especially helpful when you start learning how to work
with Karaoke CD+G Creator.

To leave the shortcut bar visible, but to disable animations, select Preferences from File menu and
uncheck Animate shortcut bar option.

Lyrics editor

Lyrics editor allows you to edit lyrics, synchronize them, and to insert events in the text that control how
your song will look like.

Lyrics editor is a simple text editor window with additional color information that describe word's
synchronization status.

Grey text represents lyrics that are not
synchronized

Brown text represents lyrics that are
already synchronized

White text represents an active word
during synchronization process. 

During playback white is used to sweep
the words.

When lyrics are synchronized lyrics editor displays one more information -- the current word. It is
represented by the underline. To change the current word simply click it. The current word's label is
automatically selected in the soundtrack panel.

There are several ways of providing lyrics to Karaoke CD+G Creator. You may:

Type the lyrics in
Import lyrics from the text file
Import lyrics from MIDI karaoke file
Paste the lyrics from the clipboard
Search for lyrics on the internet

Lyrics editor allows to synchronize lyrics with music. For more information please see Synchronizing
lyrics section.
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Entering lyrics

The most obvious way to enter lyrics is to type them in. To do this activate the lyrics editor by clicking on it
and start typing. You may listen to the song -- to start the playback use buttons on the toolbar.

Karaoke CD+G Creator provides more ways of entering lyrics. You may:

Import lyrics from the text file
Import lyrics from MIDI karaoke file
Paste the lyrics from the clipboard
Search for lyrics on the internet

Import lyrics from the text file

To import lyrics from the text file use Import lyrics toolbar button ( ) or choose Import lyrics from a
text file command from File menu.

Text file should contain lyrics in plain text format. If you are using international characters or complex
script, make sure to use Unicode encoding (select it in Encoding combo box).

Import lyrics from CD+G file

One of the most exciting features of Karaoke CD+G Creator is an ability to import existing CD+G songs.
This allows to re-edit commercial editions of karaoke songs with endless possibilities -- use this to change
font and images, fix broken characters, change lyrics or create parodies. Karaoke CD+G Creator imports
both lyrics and synchronization, so the most cumbersome part of the song creation is already done,
leaving you all the fun.

To import CD+G song select Import CD+G File command from File menu or click Import CD+G File
button on the toolbar.

First you need to select file containing CD+G songs. Two file formats are supported -- CDG BIN file. If you
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use CDG file, Karaoke CD+G Creator will automatically look for MP3 file of the same name and use it as a
soundtrack.

If Insert 'Clear Screen' events automatically is checked, Karaoke CD+G Creator will detect when
entire screen is erased in CD+G song and will insert 'Clear Screen' events at the same places in the
imported song. This help to maintain the text flow for page-by-page songs (SoundChoice songs give very
good results with this option enabled).

Import process takes a while (up to half a minute on a slower computer). Once it is completed you will see
the imported lyrics in the lyrics editor. Please check for spelling mistakes, as some of the characters may
be recognized incorrectly.

NOTE:
1. Not every song can be imported. Duets are not supported, also songs using scrolling will not
import.
2. Optical character recognition (OCR) is not perfect and may sometimes make an error. Please
check the lyrics for spelling mistakes.

Import lyrics from MIDI Karaoke file

MIDI Karaoke files contain lyrics already synchronized with music. To import lyrics from MIDI Karaoke file

file use Import MIDI lyrics toolbar button ( ) or choose Import lyrics from MIDI Karaoke file
command from File menu. 

If the MIDI file contains multiple lyrics tracks, the longest track will be used.

To import both lyrics and music from a MIDI karaoke file use Import MIDI Karaoke Wizard.

Paste lyrics

Lyrics editor provides standard copy and paste functionality. You may use it to transfer the lyrics of the
song from the text processing application or web browser

To paste the lyrics from into Karaoke CD+G Creator:
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1. Activate the source application (web browser or word processor)
2. Select the lyrics text
3. Copy it to the clipboard (CTRL+C)
4. Activate Karaoke CD+G Creator, click into the lyrics editor in and paste the lyrics (use CTRL+V

keyboard shortcut, Paste toolbar button ( ), or Paste command from Edit menu)
5. Lyrics will be inserted at the current cursor position.

Search for lyrics

Lyrics for most of the songs can be found on the internet. Karaoke CD+G Creator contains a helper tool
that will run the search for lyrics in your web browser.
To search for the lyrics on the internet use choose Search the web for lyrics command from File menu.

You may enter the name of the artist, the title of the song, and part of the lyrics of the song (if you
remember them). 

By default Karaoke CD+G Creator uses Google to search for lyrics -- once you click OK the search will
open in default web browser. Once you have found the song, select it and paste into the lyrics editor. Click
here for more information on pasting lyrics.

You may also use a different search engine (we will be adding more of them in the future). In search
engines other than Google only the artist name and title are used.

Working with soundtracks

The soundtrack is a background music that will play when you play your custom CD+G song. It may be an
instrumental recording, a real song with removed vocals, or a MIDI song converted into appropriate format.
Currently Karaoke CD+G Creator allows you to use the following file formats: WAV (Microsoft Windows
soundfiles) and MP3 (but with constant bitrate only). 

To choose the soundtrack click Load Soundtrack toolbar button ( ) or choose Load Soundtrack
command from File menu. If it is the first time you use the specified soundtrack, Karaoke CD+G Creator
will scan its contents to increase the performance (during this process FPR file is created; it contains a
preview of the soundfile and can be deleted if no longer necessary).

The soundtrack is displayed in the soundtrack panel. To play the soundtrack use buttons on the toolbar or
commands from Play menu. For more intormation on playing files see Playback controls section.
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To replace the soundtrack with a different file (ie. with the same song, but after vocal removing), simply
choose Load soundtrack again. All synchronization information will be retained.

Playback controls

To play the soundtrack use toolbar buttons or commands from Play menu.

Start Ctrl+1 Start the playback from current cursor position

Pause Ctrl+2 Pauses the playback and resumes it

Stop Ctrl+3 Stops the playback. Cursor stays at the last played position.

Rewind Ctrl+4 Moves the playback position 10 seconds backwards

Forward Ctrl+5 Moves the playback position 10 seconds forward

Playback
speed

Allows to change the playback speed

Play from
start

Ctrl+6 Moves the cursor to the start of the file and starts the playback

Play current
word

Ctrl+7 Plays the current word (starts 1 second before and ends 1 second after)

Play current
word (loop)

Ctrl+8 Plays the current word in loop

During the playback the cursor moves as the playback position changes. Also, if Highlight lyrics during
playback option in Synchronize menu is selected, Karaoke CD+G Creator highlights words in lyrics
editor.

TIP: If the song is fast paced and you are having problems synchronizing it, use one of the lower
playback speeds. But please remember that the sound might be slightly distorted.

Synchronizing lyrics

The most important step in the process of creating karaoke songs is synchronizing the lyrics with the
music. To allow the performer to sing along the words need to be highlighted as they should be sung.

To synchronize the words you have typed in or imported use commands from Synchronize menu or
buttons from synchronization group on the toolbar. 

The first step will usually be to synchronizing the entire song – to do this select Synchronize entire song

button ( ) or Synchronize entire song menu command. Karaoke CD+G Creator will enter the
synchronization mode and the synchronization toolbar will appear. 

The lyrics will be colored to visualize the current synchronization state – brown color marks the part of the
lyrics that have already been synchronized, the white color highlights the word that is to be synchronized
next, and gray is applied to the words that have not been synchronized yet.

To synchronize the highlighted word you have to press the SPACE key or select the Set toolbar button at
the moment that the word should be sung. The currently highlighted word will be marked as synchronized
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and the next word will become highlighted. You may pause and restart the playback using standard
playback controls (Play, Pause, and Stop), and if you make a mistake you may press the Backspace key
or select Back toolbar button. The last synchronized word will become unmarked. You may also move the
playback position ten seconds backwards by pressing minus key or selecting Rewind toolbar button – all
the synchronization information for the last ten seconds will be erased.

If you make a mistake or for some other reason do not reach the end of the song in a single
synchronization pass, fear not. You may continue the synchronization from the place you have stopped by

selecting Continue synchronization toolbar button ( ) or menu command. If you want to redo the
synchronization from the certain point, place the cursor there and select Synchronize from cursor

toolbar button ( ) or menu command. Note that all the synchronization information after the selected
word will be deleted. One more possibility is to retry synchronizing one of the completed lines. To do this

place the cursor in the line you want to redo and select Synchronize current line toolbar button ( ) or
menu command. All the synchronization information in the current line will be deleted, but all the rest of the
song will remain as it is.

To check the results of the synchronization you need to make sure that Highlight lyrics during playback
option is checked (this corresponds to pushed in Highlight during playback button on the lyrics pane

toolbar ) and play the file. As the file is played back, the lyrics that should be sung are highlighted.
Note that the words are highlighted letter-by-letter, so the singer can see how fast should the word be
sung. During the playback you may move the cursor and the playback will resume from the selected
word. 

If you find synchronization mistakes, there are two ways you may fix them:

Modifying word synchronization using soundtrack panel
Using Adjust current word dialog box

Modifying synchronization using soundtrack panel

Soundtrack panel can be used to adjust the start and the end of the word. This can be done in many
ways.

To move the entire word click on the label and move it up and down. The word's duration will
not be changed. The duration of the previous and the next word will be modified
accordingly. You may not move the word earlier then the start of the previous word, and
later than the end of the next word.

In this example you see mouse pointer on label 'good'.

To move the end of the word and the beginning of the next word position click and drag
the word boundary (the red horizontal line).
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In this example end of word 'a' and start of word 'good' would be adjusted.

To move the start/end of the word without moving the end of the previous/next word hold
down the SHIFT, and then click and drag the word boundary.

Only the beginning of the word 'good' would be moved.

Only the end of the word 'good' would be moved.

To place a cursor over the label boundary keep the CTRL key down and click as if label was
not there.

Adjust current word dialog box

To adjust the synchronization of the word, click on the word in the lyrics editor (it will become underlined),

and click Adjust current word toolbar button ( ) or select Adjust word synchronization menu
command. You may also right-click the word and select Adjust word synchronization command from a
pop-up menu.

Ajdust word synchronization dialog box will appear under the current word.
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Word placement displays current time for start and end of the word in seconds. To move them use
buttons below. 

TIP: To change the amount that is added or subtracted to the time click on Settings button and
modify Adjust amount value.

You may check the synchronization of the word using playback buttons.

Play and stop will start the playback before the word and and stop after it is highlighted. Karaoke CD+G
Creator will highlight the word during playback.

Play in look will continuously play current word.

By default the playback is started two words before current word and stopped one word after the
current word. To modify this values click Settings and change Play before and Play after values.
You may tell Karaoke CD+G Creator to start several words earlier or enter a time value in seconds.

Stop button stops the playback.

After you have adjusted the synchronization for the word you may close the dialog box using Close button,
or you may move to the next or previous word using the appropriate buttons.

Shift Labels

Shift Labels command from Edit menu allows to move all labels at once.

Offset is the value in milliseconds that will be used to move all labels. Negative value moves labels
backwards.

Creating CD+G files

Before creating CD+G file that can be burned to a CD+G disc you need to make sure that your song looks
good.

Using CD+G Preview window

There are several ways of changing the appearance of CD+G song:

Using styles
Modifying CD+G settings
Using CD+G events

Once the song looks good you are ready to write it to CDG file.

Writing CD+G files

You may play CD+G song with Power CD+G Player

Playing CD+G files
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Karaoke CD+G Creator does not burn CD+G discs. To do this you need Power CD+G Burner. To learn
move visit Power CD+G Burner website.

Using CD+G Preview window

CD+G preview window is located above the lyrics editor. 

It displays the CD+G preview of the current part of the lyrics -- this is how your song will look on the TV
screen. Please observe that the content of the preview window changes as you change the position of the
cursor in the lyrics editor -- it always displays the page cursor is currently at.

TIP: If your computer is slow, rendering preview make take a long time and your work will be
uncomfortable. To avoid this either hide the preview window or disable automatic updates
(clicking Update button will render the preview at the current cursor position).

Using styles

To apply a predefined visual style to your song click Styles button on the toolbar ( ) or select Styles
command from Create menu.

http://www.powerkaraoke.com/src/prod_powercdgburner.php
http://www.powerkaraoke.com/src/prod_powercdgburner.php
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Song details section of the dialog box allows you to enter title of the song, artist name, and text that will
be displayed as your company information (probably something like Presented to you by DOBLON).
Credits are displayed after the song is finished.

Tip: To force a new line in Title, Artist, or Company name fields, use ^ character.

What is style?

Karaoke CD+G Creator allows to set styles for:
· Title: image displayed before the song

· Credits: image displayed after the song is finished

· Song: colors, text formatting, page layout, and image (in Pro version only) of the lyrics

Each of this styles can be applied individually, or it is possible to use presets.

Style preset combo box allows to select one of predefined templates. It will change all styles in Applied
styles. You may store your combination of Title, Song, and Credit styles using Add button. To save
changed combination use Save button. Delete button removes your preset from the list.

Applied styles lists styles used for each of the sections of the song. To change the style select it in
Applied styles list and then choose the new style from Available styles combo. Selecting (Unused) will
disable the style.

Style editor button starts Style Editor dialog box which allows you to create your own styles.

Preview window displays the preview of the style selected in Applied styles list.
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Selected styles will be applied to the song when you select OK button.

Modifying CD+G settings

Usually you will want to adjust CD+G parameters to your liking. To open CD+G Settings dialog box click

CD+G Settings button on the toolbar ( ) or select CD+G Settings command from Create menu.

Font

This setting specifies which font will be used for the lyrics and how large the letters should be. If you are
trading you PKD files make sure that you use fonts that are installed on the destination computer.

Text Effects

Select the text effect you want to apply. You have the choice of Outline (you may choose the size of the
outline), Shadow and Heavy shadow. The color of the text effects can be set in Colors dialog box.

You may enable any of the following text effects:

· None Text effects are disabled

· Outline Text is outlined by a single pixel

· Shadow A one pixel shadow is added to text

· Heavy shadow A two pixel shadow is added to text

· Outline (2-5 pixels) An outline of a selected width is added to the text

The color of the effect is controled separately from the color of the text. By default efects are painted in
black.

Note: Enabling text effects decrease the speed of display the text. For the fast-paced songs it is
recommended to disable the text effects.

Vertical alignment

Allows to change the placement of the lines of the text. You may select Center, Top, or Bottom which
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would place the text at the appropriate part of the screen, or choose Space evenly, which makes sure that
the first line is at the top, the last at the bottom, and all the spaces between the lines are equal.

Horizontal alignment

This setting controls the way the individual lines of text are placed. You have the choice of Center, Left,
and Right.

Lines per screen

Allows to specify the maximum number of lines to be shown. Note that if the font size is too large, the
actual number of lines may be lower.

Additional spacing

The number of pixels to insert between the lines.

Squeeze text and do not break lines

When this option is selected Karaoke CD+G Creator will not break lines -- it will resize it horizontally so
every line fits the screen. This may help placing the text in the song, but if the lines are too long may
decrease the readability of the text.

Sweep words

Uncheck this option if you want to highlight the entire word at once, instead of coloring it gradually as it is
sung.

Syllable separator

Allows to select the character that separates syllables in the song text. By default the syllable separator is
a hyphen (-).

Hard space

This option allows to change the default character that will be displayed as a space, but does not split the
word (e.g. hard_space will be treated as a single word). By default the hard space character is an
underline (_). 

Colors

Allows to change the background, border and text color. Simply choose the appropriate color from the list
or use More button to select the custom color.

Display mode

You may also select the text display mode. Choosing Page by page will result in the standard
paged display. Overwrite will disable the screen erasing and the new words will overwrite the
already sang. And Scrolled mode will generate the long flow of text that will move upwards with the
highlighted line always in the middle.
Mode information on display modes can be found in Display modes section.

Images

This group of options allows to select the pictures that are to appear before the song and after the song.
By default these pictures are disabled. Checking Insert silence to accommodate the picture ensures
that the title picture will not interfere with the flow of the song (this option works for BIN files only).
To learn more about using images in Karaoke CD+G Creator see Images section.

Preset

You may save a current set of options and use it later for different song using the Save button. To invoke
the preset select if from a pop-down list. To delete the existing preset use Delete button. 

Apply

Apply button will update the preview window of lyrics editor so that you will see the changes you have
made (you may have to move CD+G Settings dialog to show preview window beneath it).
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Display modes

 Note: These settings are available in Pro version only. Karaoke CD+G Creator has paged
display mode only.

Karaoke CD+G Creator Pro has 3 display modes.

Page by page will result in the standard paged display. Full page of lyrics is displayed, and when it is fully
highlighted, a new page is presented.

Overwrite will disable the screen erasing and the new words will overwrite the already sang.  This mode
should be used when there is an image on screen -- it will ensure that image is not erased.

Scrolled mode will generate the long flow of text that will move upwards with the highlighted line always in
the middle. Note that some songs (faster ones) can not be presented properly in Scrolled mode.
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Writing CD+G Files

Click Create CD+G File button on the toolbar ( ) or select Create CD+G File command from Create
menu. You may also press F2 key on the keyboard.

If you want to write this track to a CD, you need to select BIN as the output type. Selecting CDG output
type will allow you to preview the result in Power CD+G Player. By default the output file is created in the
same directory as the soundtrack file. Make sure that you have all necessary user privileges, or change
the output file location. 

Please note that most of the settings is the same as those in CD+G Settings dialog box.

If you would like to preview the output file, make sure that Open in Power CD+G Player when done
option is checked. You may select a different software CD+G player if you have one -- use Choose
player button to do this.
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Tip: If Power CD+G Player Pro is installed on your computer, you will be prompted to use it as a
default CD+G player in Karaoke CD+G Creator. 
Click here to visit Power CD+G Player Pro website.

Now click OK to create CD+G file.

Playing CD+G files

Power CD+G Player can be used to play the tracks you create with Karaoke CD+G Creator.

It is a good idea to view the song in full before burning it to the CD.

What's new

Karaoke CD+G Creator is based on PowerKaraoke, but it introduces many new features. Below are the
most important of them.

Version 2.0.1.

· New user interface

· Shortcut bar

· Styles

· Parallel duets

· Playback speed change (lower playback for easier synchronization)

· Create New Song wizard

· Countdown event

· Time placement of images

· Automatic countdowns

· Squeeze text option

· Improved vocal remover

· Adjust word synchronization

· Apply in CD+G Settings dialog

· Improved Import MIDI Karaoke Wizard

· Search for lyrics on the web

· Search for MIDI Karaoke on the web

· Make lyrics uppercase

· Lyrics export

http://www.powerkaraoke.com/src/prod_powercdgplayerpro.php
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· Preferences

Removing vocals
Creating duets
Using CD+G events
Images
Searching for MIDI Karaoke on the web
Batch file create
Batch MIDI import
Advanced lyrics import
Exporting lyrics

Removing vocals

Power Vocal Remover is a tool that allows removing a lead vocal from a stereo recording. It bases on a
common technique used in song mastering – lead vocal is usually mixed equally between both stereo
channels. 

To start Power Vocal Remover click Vocal Remover button on the toolbar ( ) or select Vocal
Remover from Toolbox menu.

Files

Here you may select the input and the output of the processing. By default the input file is the current
soundtrack and the output name is created by appending –VR to the input name.

By selecting Replace the soundtrack with the output file you may automatically change the
soundtrack to the result of the processing.

Parameters

Vocal Remover has several parameters.
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Level controls the intensity of the effect. By default the reduction is as heavy as possible.

Changing Balance can give better results with songs where vocals are panned to one of the channels.

Attenuation allows to increase the volume of the output if necessary.

Bass boost and Treble boost control the amount of low and high frequencies that are left untouched by
the algorithm. Enabling them usually improves the quality of the vocal removed material.

Preview

Play/Stop button starts the playback and allows to perform a real time tuning of the effect. You may
change the playback position by clicking on the progress bar left to the button.

Usage tips

Vocal Remover gives good results for many CD tracks. You need to remember that it is not a magic tool
and will not work if vocals are mixed in non-standard way. Sometimes the song is produced in a different
way and sound effects (reverb or chorus) applied to the lead vocal disturb the algorithm. And also MP3
files usually do not give good results as compression changes the internal structure of the recording, so it
is best to use WAV files created from CD tracks (converting MP3 to WAV will not improve quality).

Creating duets

Simple duets

Basic version of Karaoke CD+G Creator offers basic duet support. It changes text settings using
predefined duet styles to visualize the change of the singer. For more information please see section
Using duet events.

Advanced duets

 Pro version allows to create professional parallel duets. The most important features are:

Duet Wizard that helps to assign lyrics to singers
Full duet synchronization mode
Divided CD+G screen for duets (Singer 1 at top and Singer 2 at the bottom of the screen) with
separate settings for each of the singers

Please note that in tutorials section you will find Create song with duets tutorial.
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General remarks

In duet mode Karaoke CD+G Creator divides the song in three modes: parts that are to be sung by Singer
1, those to be sung by Singer 2, and parts of the song sung together by both singers.

Parts sung by both singers are displayed in the same manner as the lyrics in non-duets song. But when
Karaoke CD+G Creator finds duet part, it divides the screen into two parts and displays lyrics for singer 1
at the top, and lyrics for singer 2 at the bottom (see image above).

To enable duets in Karaoke CD+G Creator use Full duet mode toolbar button ( ) or select Enable full
duet mode from synchronization menu.

Non-split duets

If you do not wish to split the screen between two singers and rather have words for both singers
displayed one after another, disable Full duet mode before creating CD+G file (it must be enabled in the
synchronization mode). Also the lyrics for both singers should interleave -- they need to be in the same
order as they should be displayed (so in general this will be like duets in PowerKaraoke, but with
concurrent highlighting.

We have prepared an example that shows this -- it is brother john no split.pk2 file located in
Examples subdirectory of Karaoke CD+G Creator directory (usually C:\Program
Files\Doblon\Karaoke CD+G Creator Pro or Documents\My Karaoke\Karaoke CD+G Creator Pro
Examples on Windows Vista). 

Multiple languages

Full duet mode can be used to create song in two languages. 
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Please see brother john two languages.pk2 file located in Examples subdirectory of Karaoke CD+G
Creator directory (usually C:\Program Files\Doblon\Karaoke CD+G Creator Pro or Documents\My
Karaoke\Karaoke CD+G Creator Pro Examples on Windows Vista). 

Duet Wizard

Duet Wizard allows to assign portions of the lyrics to each of the singers.To start it click Duet Wizard

button on the toolbar ( ) or select Duet Wizard from Edit menu.

Lyrics assigned to Singer 1 are red, lyrics assigned to Singer 2 are blue, and those that should be sung
together are grey.

To assign a part of the lyrics to particular singer (or to both singers) select this part in the lyrics window
(drag mouse to select the text) and then click Selection button next to the singer mode you want to use.
Duet Wizard always uses full lines, so if you position the cursor in the middle of the line and then click
Selection, entire line will be assigned.

From cursor to end buttons allow to assign all song lyrics from the current cursor position to the end of
the song to one of the duet modes.

Set all will assign entire song to one of the modes.

After you close Duet Wizard with OK you will see that Duet events have been inserted in the text of the
song.
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Please note that you can enter Duet Wizard many times and the current duet assignments will not be the
starting point for further editing.

Full duet synchronization

To enable full duet synchronization (if it is not enabled already) click Full duet mode button on the toolbar

( ) or select Enable full duet mode from Synchronize menu. Duet tab control will appear above the
lyrics editor.

Duet tabs allow switching between duet modes. No duets is for editing lyrics -- it displays the entire text of
the song. The other three are for each of the duet roles.

Selecting Singer 1 tab will activate Singer 1 duet mode. It will dim the lyrics that are not assigned for
Singer 1 and preview will show Singer 1 lyrics only.

Duet tabs are used to synchronize the duet song. Unfortunately synchronizing duet songs takes three
times as long as regular songs -- you have to synchronize part for both singers, and then individual parts
for each of the two singers.

Please note that synchronization labels in the soundtrack panel are not visible in No duets mode -- you
need to activate one of the duet tabs to display and edit them. No duets mode allows text edits -- if you
need to change text go to No duets, do the editing, and return to duet mode.

Synchronization for each of the duet modes works in the same way as synchronization in non-duet way.
To learn more about it please see Synchronizing lyrics section.

Duet settings

To adjust the settings for duets double-click any of the duet events (Duet dialog box will appear) and
select Duet settings button to open Duet settings dialog box.
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Here you can define the text settings for Singer 1 and Singer 2 -- just select the mode on the top and
adjust the settings. Please note that the number of lines apply to half of the screen only (Singer 1 uses the
upper part and Singer 2 uses the lower part of TV screen). Settings for Both singers mode are copied
from general CD+G settings.

Using CD+G Events

Karaoke CD+G Creator gives you the full control over the CD+G track you create. You may change the
text properties, colors, and display images anywhere in the song. These extra options are available by the
means of CD+G events. CD+G event is executed after the preceding word is painted or highlighted (it
depends of the event, eg. Clear screen is triggered after highlighting, while Colors event during painting).

You work with CD+G events in lyrics editor. They are displayed as boxes with text describing the type of
the event.

In order to insert a CD+G event position the cursor in the place the event should be inserted and click

Insert Event button on the lyrics pane toolbar ( ) or  select Insert CD+G event menu command from
Edit menu. Insert CD+G Event dialog box will appear, allowing you to select the event type from the list.
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Below is the list of events available in Karaoke CD+G Creator. Please remember that some of them are
available in Pro version only. After you select the type of the event another dialog box is displayed that
allows to set the properties of the selected event type.

Clear Screen Causes a screen to be erased after the last word before the event becomes
highlighted

Colors Allows to change colors for text (both normal and highlighted), effects,
background, and border

Countdown Inserts countdown mark before the next word that helps the singer to start on time
Display Image Allows to display an image on the screen. Before the picture is displayed the

screen is cleared.
Duet Allows to change the coloring of the text to visualize the change of a singer

 In Pro version duets can be parallel

 Overprint
Image

Allows to display the image anywhere on the text. It may also be used to erase a
part of the screen

 Set Text Area Using this event you may display the image and the text on screen at the same
time. It also allows to change the portion of the screen that is used to display the
lyrics

Text Settings Allows to modify the properties of the text

Events can be edited. To edit an event double-click it in the lyrics editor or right-click it and select CD+G
Event Properties command from pop-up menu.

Events can be deleted like other text. There is one more editing feature available for events -- you may
copy event and insert it in some other place in the song. to do this right-click an event to copy and select
Copy Event command. Now right-click in the place you want the copy of the event to appear and select
Paste CD+G Event command from pop-up menu.

Clear Screen event

This CD+G event will cause a screen to be erased after the last word before the event becomes
highlighted. 
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You may select the mode that will be used to clear the screen (the default Simple is the fastest and
results in immediate screen erase). Reverse will cause the effect to be reversed (ie. Left to Right will
become Right to Left).

 If scrolling display mode is selected, after clearing the screen lyrics will painted from the top of the
screen.

Colors event

Colors event allows to change colors for text (both normal and highlighted), effects, background, and
border.

Colors change will affect all words after the event. We do not recommend changing background and
border colors in the middle of the page, only after of immediately before Clear screen events.

With Colors event it is possible to change the sweep mode from highlighting text to highlighting the text
outline. To do this select the same color for normal and highlighted text, and then select different colors for
normal and highlighted effects. Also make sure to enable Outline text effects in CD+G Settings dialog
box.

Due to CD+G format limitations (only 16 colors can be used at one time) if you use too many color
changes on one screen you may experience problems (you will not the colors that you want). We advice
to use no more than 6 color sets with disabled effects and no more that 3 color sets with enabled effects.

 Color event needs to be used cautiously if you choose to display image using Set text area event, as
the maximum number of colors on screen is 16, and usually image uses up to 10. With one color for
background and one for border this leaves 4 colors for text -- that is 2 color sets with no effects and only
one with effects enabled.

Countdown event

Countdown event tells Karaoke CD+G Creator to display a countdown marker before the next word is
highlighted. In the current version of the program countdown marker is a string of dots.
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Countdown time defines the duration of the countdown (2 seconds by default).

Number of items is the number of characters to display.

Use repeated character select the default mode of repeating the single character several times. You
may change the character used in Character to use field.

Use text allows to enter text that will be used as a countdown. The text has to be entered into Text to
use field.

Display Image event

Display Image event allows to display the image on the screen. Before the image is displayed the screen
is cleared.

The image will be displayed immediately after the last word before it is highlighted. 

 In Pro version you may modify this behaviour with Synchronization settings.
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File

You need to select the file containing the image. The following formats are supported:

BMP (Windows bitmaps) 
JPG 
PNG 

To invoke the file selection dialog box select Browse button.

Note: CD+G image format is 288x192.

Images may be of any size and color depth, however if they contain more than 16 colors or are larger than
288 x 192, they will be automatically converted to CD+G format. If you would like to use an image editing
software to decrease the color depth and resize the images, make sure you save them as 4-bit BMP file.

Link to file and Insert contents options

By default Karaoke CD+G Creator leaves the images on the hard disk and reads them when needed
(Link to file option selected). This behaviour reduces the size of PK2 files and allows making changes to
the images using image editors (you do not have to visit event again -- just edit the image and re-create
CDG file). However if you delete the image file from disk, it will not be available.

If you would like to share your PK2 files select Insert contents option. It will cause Karaoke CD+G
Creator to include the image in PK2 file, so you may send it over to a friend or delete image files. Note that
if image source file is deleted you will not be able to edit it any more.
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Keep on screen for N seconds

This setting controls how long will the image be visible before it is erased. Note that painting time (up to 10
seconds for a full screen sized picture) and erasing is not included, so the total time that the picture takes
equals to the sum of painting time, display time, and erase time.

Selecting 0 will cause the image to become erased immediately after it is fully painted.

Border color

Choose the color that will surround the image. Note that it is different than Borders color setting in Colors
CD+G event, as it refers to the area not taken by the image, and not only to the border of the screen. If you
are using image as a background (in Set Text Area event) the background color must match the
background color of the text.

Display mode and Erase mode

These settings control the way image is painted and erased. By default images are painted from left to
right and erased immediately. You may change it by selecting any of the display effects. 

Checking the Reverse checkbox will cause the effect to run backwards, for example Left to Right mode
will become to Right to Left.

Note that selecting Fade and Simple as Display mode will cause the screen to go blank for several
seconds (the image still needs to be painted, and this is done in a way that is not visible, yet still takes
time).

Alignment

You may select the position of the picture if it is not full screen sized. Simply select the appropriate
rectangle. By default images are centered.

Force scaling

This option will force the image to be scaled to the size defined in Width and Height boxes. This size
cannot be larger than the full screen (288 x 192).

Dithering

If the number of colors in the image is larger than 16, Karaoke CD+G Creator will reduce it. You may
select the algorithm that is used to make the image look as good as possible with the lower number of
colors. Selecting none will disable any dithering. The simples way to see how each of the algorithms
works is to select it and then to click the Preview button.

Resizing

This setting controls the way image is scaled if its size is not 288 x 192 (full screen).

Fit will cause the image to be scaled up or down to take as much screen as possible.
Fit if larger (default setting) will scale the image only if it is too large, it will not stretch it. 
Crop will not scale the image and will display as much of it as possible. 

All resizing modes retain aspect ratio of the image.
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 Synchronization (Pro version only)

By default the image will be displayed immediately after the last word before it is highlighted. It is possible
to define the exact time when it should appear (but remember that image needs to fit between the
previous and the next word).

You may define the exact time the image should be visible (From the start of the song) -- the value in
Display at box is a position in seconds. You may use Copy from cursor button to enter current cursor
position into Display at box.

You may also define time before the next word is highlighted (Before the next word) or after the previous
word finishes highlighting (After the previous word).

Please remember that the time position refers to the moment image is fully painted. It does not include
painting nor erasing time.

Preview

Click this button to see how the picture will look.

Notes

· Images with more colors take longer to paint.

· Inserting image in the middle of the song may use up the time and cause the loss of synchronization 

Duet event

Duet event allows to change the current duet mode.

In regular version of Karaoke CD+G Creator duet mode changes the coloring and alignment of the text to
visualize the change of a singer.

 In Pro version with full duet mode enabled duets can be parallel. The upper part of the screen is taken
by Singer 1, and the lower by Singer 2. The lyrics for each of the singers are highlighted independently.
Please see Creating duets section for more information.

All words after the event will be colored according to the selected mode. Three duet modes are available:

· Singer 1 

· Singer 2 

· Both 

You may view and change the predefined coloring and alignment assigned to duet modes by clicking Duet
settings button.
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Mode allows to change the duet mode that you would like to modify. Only Singer 1 and Singer 2 modes
are available -- for Both Karaoke CD+G Creator uses global CD+G settings for the song (as defined in
CD+G Settings dialog box).

Color and Highlight allows you to change the color of the text assigned to the selected mode, while
Alignment controls the alignment of the text assigned to the selected mode.

 In Pro version you are also able to set lines count and vertical alignment for each of duet modes.

The duet settings are global for the song.

Note: Colors and Text settings flags overwrite the duet settings.
 

Overprint image

 Note: This event is available in Pro version only.

This event allows to display the image anywhere on the text. It may also be used to erase a part of the
screen.
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As you can see the settings are very similar to Display image event.

File

You need to select the file containing the image. The following formats are supported:

BMP (Windows bitmaps) 
JPG 
PNG 

To invoke the file selection dialog box select Browse button.

Note: CD+G image format is 288x192.

Images may be of any size and color depth, however if they contain more than 16 colors or are larger than
288 x 192, they will be automatically converted to CD+G format. If you would like to use an image editing
software to decrease the color depth and resize the images, make sure you save them as 4-bit BMP file.

Link to file and Insert contents options

By default Karaoke CD+G Creator leaves the images on the hard disk and reads them when needed
(Link to file option selected). This behaviour reduces the size of PK2 files and allows making changes to
the images using image editors (you do not have to visit event again -- just edit the image and re-create
CDG file). However if you delete the image file from disk, it will not be available.

If you would like to share your PK2 files select Insert contents option. It will cause Karaoke CD+G
Creator to include the image in PK2 file, so you may send it over to a friend or delete image files. Note that
if image source file is deleted you will not be able to edit it any more.

Display mode

These settings control the way image is painted. By default images are painted from left to right. You may
change it by selecting any of the display effects. 
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Checking the Reverse checkbox will cause the effect to run backwards, for example Left to Right mode
will become to Right to Left.

Position

You may select the position of the picture by selecting the appropriate rectangle.

You may also display the image in any part of the screen. To do this select Custom and enter coordinates
of left top corner of the image position.

Force scaling

This option will force the image to be scaled to the size defined in Width and Height boxes. This size
cannot be larger than the full screen (288 x 192).

Display during

You may choose whether the image should be displayed after the preceding word is painted, or
highlighted.

Erase image

This option will erase the image instead of painting it (used if you have displayed an image in the same
place before).

Dithering

If the number of colors in the image is larger than 16, Karaoke CD+G Creator will reduce it. You may
select the algorithm that is used to make the image look as good as possible with the lower number of
colors. Selecting none will disable any dithering. The simples way to see how each of the algorithms
works is to select it and then to click the Preview button.

Resizing

This setting controls the way image is scaled if its size is not 288 x 192 (full screen).

Fit will cause the image to be scaled up or down to take as much screen as possible.
Fit if larger (default setting) will scale the image only if it is too large, it will not stretch it. 
Crop will not scale the image and will display as much of it as possible. 

All resizing modes retain aspect ratio of the image.

Colors

Use this setting to define the number of colors that will be added to the current palette to match the colors
in the image. Below are some suggestions how to set this option regarding the types of the usage:

Maximum Use this setting if you are displaying the image on the clear screen. You may also use
it if this is the only image displayed on the current page and you do not change the
colors for text 

10, 8 Use this setting for the color-rich images for the songs with changing text colors (or
duets)

4 This is the best setting for small images (stars, tick marks) displayed on screen.
Remember that if you want to display the same image more than one you should
select this setting for the first image only
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Use current palette Use this setting if you are displaying the image for the second time or if you have
already used up many of the palette entries (the total number of available colors is 16)

Preview

Click this button to see how the picture will look.

Set Text Area event

 Note: This event is available in Pro version only.

Using this event you may display the image and the text on screen at the same time. It also allows to
change the portion of the screen that is used to display the lyrics.

If you choose to display the image, it will be painted according to the selected options and will not be
erased. The lyrics will appear at the defined area. Using this setting you may display the banner on the top
of the text or an image anywhere on the screen.

Clear screen or Display image event resets the text area to the full screen.

Note: If the selected display mode is other than Overwrite, the image will be visible only on the first
page.
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Display image

Select the image you would like to appear on screen. You need to select the image file using Properties
button before Display Image checkbox becomes active.

Properties button will open Display image dialog box, the same as for Display Image event.

Note that you the erase mode will not be used event if you define it, as the image will stay on screen.

Use all available area

Select this option if you want text to use all the screen that is not used by the image.

Copy to custom area

This button will set the custom area dimensions to the area not used by the image.

Define custom area

Using this option you may define the rectangle that will contain the lyrics. It may be useful if you want the
lyrics to appear in the middle of the picture or simply move the text a little to the right. The full screen has
width of 288 and height of 192 pixels.

The custom area is visualized by the blue frame (black area represents full screen). You may modify it by
dragging the edges of the frame.
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Text Settings event

Text Settings event allows to modify the properties of the text.

Font

This setting specifies which font will be used for the lyrics and how large the letters should be. If you are
trading you PK2 files make sure that you use fonts that are installed on the destination computer.

Text Effects

Select the text effect you want to apply. You have the choice of Outline (you may choose the size of the
outline), Shadow and Heavy shadow. The color of the text effects can be set in Colors dialog box.

You may enable any of the following text effects:

· None Text effects are disabled

· Outline Text is outlined by a single pixel

· Shadow A one pixel shadow is added to text

· Heavy shadow A two pixel shadow is added to text

· Outline (2-5 pixels) An outline of a selected width is added to the text

The color of the effect is controled separately from the color of the text. By default efects are painted in
black.

Note: Enabling text effects decrease the speed of display the text. For the fast-paced songs it is
recommended to disable the text effects.

Vertical alignment

Allows to change the placement of the lines of the text. You may select Center, Top, or Bottom which
would place the text at the appropriate part of the screen, or choose Space evenly, which makes sure that
the first line is at the top, the last at the bottom, and all the spaces between the lines are equal.

Horizontal alignment

This setting controls the way the individual lines of text are placed. You have the choice of Center, Left,
and Right.

Lines per screen

Allows to specify the maximum number of lines to be shown. Note that if the font size is too large, the
actual number of lines may be lower.

Additional spacing

The number of pixels to insert between the lines.
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Sweep words

Uncheck this option if you want to highlight the entire word at once, instead of coloring it gradually as it is
sung.

Images

Karaoke CD+G Creator allows to display images anywhere in the song. It also has shortcuts for adding
title and credits screen.

The following formats are supported by Karaoke CD+G Creator:

BMP (Windows bitmaps) 
JPG 
PNG 

To invoke the file selection dialog box select Browse button.

Note: CD+G image format is 288x192.

Images may be of any size and color depth, however if they contain more than 16 colors or are larger than
288 x 192, they will be automatically converted to CD+G format. If you would like to use an image editing
software to decrease the color depth and resize the images, make sure you save them as 4-bit BMP file.

 Pro version also allows to add images at the side or around of the lyrics.

See the following topics for more information:

Using title and credit images
Displaying images in the middle of the song
Displaying image and lyrics at the same time
Displaying images using styles

Using title and credit images

Title image is displayed at the beginning of the song. Credits image is displayed at the end of the song,
when the singing stops.
To define title and credit images open CD+G Settings dialog box click CD+G Settings button on the

toolbar ( ) or select CD+G Settings command from Create menu.



57Chapter 4 Getting results

4Getting results

Images

This group of options allows to select the pictures that are to appear before the song and after the song.
By default these pictures are disabled. 

To display title image select Title checkbox and then click on Settings button. Display image dialog box
will appear. To learn more about it please see Display Image event section.

The same procedure needs to be applied for credits image.

Checking Insert silence to accommodate the picture ensures that the title picture will not interfere with
the flow of the song (this option works for BIN files only).

Displaying images in the middle of the song

To display image in the middle of the song place cursor position in the place that image should appear,

click Insert CD+G Event button on the toolbar ( ), and then select Display Image event type.

Display Image event allows to display the image on the screen. Before the image is displayed the screen
is cleared.

The image will be displayed immediately after the last word before it is highlighted. 

 In Pro version you may modify this behaviour with Synchronization settings.
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File

You need to select the file containing the image. The following formats are supported:

BMP (Windows bitmaps) 
JPG 
PNG 

To invoke the file selection dialog box select Browse button.

Note: CD+G image format is 288x192.

Images may be of any size and color depth, however if they contain more than 16 colors or are larger than
288 x 192, they will be automatically converted to CD+G format. If you would like to use an image editing
software to decrease the color depth and resize the images, make sure you save them as 4-bit BMP file.

Link to file and Insert contents options

By default Karaoke CD+G Creator leaves the images on the hard disk and reads them when needed
(Link to file option selected). This behaviour reduces the size of PK2 files and allows making changes to
the images using image editors (you do not have to visit event again -- just edit the image and re-create
CDG file). However if you delete the image file from disk, it will not be available.

If you would like to share your PK2 files select Insert contents option. It will cause Karaoke CD+G
Creator to include the image in PK2 file, so you may send it over to a friend or delete image files. Note that
if image source file is deleted you will not be able to edit it any more.
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Keep on screen for N seconds

This setting controls how long will the image be visible before it is erased. Note that painting time (up to 10
seconds for a full screen sized picture) and erasing is not included, so the total time that the picture takes
equals to the sum of painting time, display time, and erase time.

Selecting 0 will cause the image to become erased immediately after it is fully painted.

Border color

Choose the color that will surround the image. Note that it is different than Borders color setting in Colors
CD+G event, as it refers to the area not taken by the image, and not only to the border of the screen. If you
are using image as a background (in Set Text Area event) the background color must match the
background color of the text.

Display mode and Erase mode

These settings control the way image is painted and erased. By default images are painted from left to
right and erased immediately. You may change it by selecting any of the display effects. 

Checking the Reverse checkbox will cause the effect to run backwards, for example Left to Right mode
will become to Right to Left.

Note that selecting Fade and Simple as Display mode will cause the screen to go blank for several
seconds (the image still needs to be painted, and this is done in a way that is not visible, yet still takes
time).

Alignment

You may select the position of the picture if it is not full screen sized. Simply select the appropriate
rectangle. By default images are centered.

Force scaling

This option will force the image to be scaled to the size defined in Width and Height boxes. This size
cannot be larger than the full screen (288 x 192).

Dithering

If the number of colors in the image is larger than 16, Karaoke CD+G Creator will reduce it. You may
select the algorithm that is used to make the image look as good as possible with the lower number of
colors. Selecting none will disable any dithering. The simples way to see how each of the algorithms
works is to select it and then to click the Preview button.

Resizing

This setting controls the way image is scaled if its size is not 288 x 192 (full screen).

Fit will cause the image to be scaled up or down to take as much screen as possible.
Fit if larger (default setting) will scale the image only if it is too large, it will not stretch it. 
Crop will not scale the image and will display as much of it as possible. 

All resizing modes retain aspect ratio of the image.

 Synchronization (Pro version only)

By default the image will be displayed immediately after the last word before it is highlighted. It is possible
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to define the exact time when it should appear (but remember that image needs to fit between the
previous and the next word).

You may define the exact time the image should be visible (From the start of the song) -- the value in
Display at box is a position in seconds. You may use Copy from cursor button to enter current cursor
position into Display at box.

You may also define time before the next word is highlighted (Before the next word) or after the previous
word finishes highlighting (After the previous word).

Please remember that the time position refers to the moment image is fully painted. It does not include
painting nor erasing time.

Preview

Click this button to see how the picture will look.

Notes

· Images with more colors take longer to paint.

· Inserting image in the middle of the song may use up the time and cause the loss of synchronization 

Displaying image and lyrics at the same time

To display image at the side or around the lyrics use Set Text Area event. To do this position lyrics editor

cursor in the place that image should be displayed, click Insert CD+G Event button on the toolbar ( ),
and then select Set Text Area event type.

 Note: This event is available in Pro version only.

Using this event you may display the image and the text on screen at the same time. It also allows to
change the portion of the screen that is used to display the lyrics.

If you choose to display the image, it will be painted according to the selected options and will not be
erased. The lyrics will appear at the defined area. Using this setting you may display the banner on the top
of the text or an image anywhere on the screen.

Clear screen or Display image event resets the text area to the full screen.

Note: If the selected display mode is other than Overwrite, the image will be visible only on the first
page.
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Display image

Select the image you would like to appear on screen. You need to select the image file using Properties
button before Display Image checkbox becomes active.

Properties button will open Display image dialog box, the same as for Display Image event.

Note that you the erase mode will not be used event if you define it, as the image will stay on screen.

Use all available area

Select this option if you want text to use all the screen that is not used by the image.

Copy to custom area

This button will set the custom area dimensions to the area not used by the image.

Define custom area

Using this option you may define the rectangle that will contain the lyrics. It may be useful if you want the
lyrics to appear in the middle of the picture or simply move the text a little to the right. The full screen has
width of 288 and height of 192 pixels.

The custom area is visualized by the blue frame (black area represents full screen). You may modify it by
dragging the edges of the frame.

Displaying images using styles

To apply a predefined visual style to your song click Styles button on the toolbar ( ) or select Styles
command from Create menu.
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Song details section of the dialog box allows you to enter title of the song, artist name, and text that will
be displayed as your company information (probably something like Presented to you by DOBLON).
Credits are displayed after the song is finished.

Tip: To force a new line in Title, Artist, or Company name fields, use ^ character.

What is style?

Karaoke CD+G Creator allows to set styles for:
· Title: image displayed before the song

· Credits: image displayed after the song is finished

· Song: colors, text formatting, page layout, and image (in Pro version only) of the lyrics

Each of this styles can be applied individually, or it is possible to use presets.

Style preset combo box allows to select one of predefined templates. It will change all styles in Applied
styles. You may store your combination of Title, Song, and Credit styles using Add button. To save
changed combination use Save button. Delete button removes your preset from the list.

Applied styles lists styles used for each of the sections of the song. To change the style select it in
Applied styles list and then choose the new style from Available styles combo. Selecting (Unused) will
disable the style.

Style editor button starts Style Editor dialog box which allows you to create your own styles.

Preview window displays the preview of the style selected in Applied styles list.
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Selected styles will be applied to the song when you select OK button.

Style Editor

Style Editor allows you to create your own visual styles.

Style editing is done in visual manner. The first step is to select the style type in Style type combo box
(you may create Title, Song, and Credit styles). Once you select the style type Current style combo box
is filled with available styles of the selected type.

There are two types of styles -- system (predefined) styles and user-defined styles. Predefined styles
have * in front of their names and cannot be altered.

Once you select a style from the Current style combo box the style preview will be displayed in Preview
window. Also fields available for the selected style type will be displayed on Available styles list. Each of
the style types has different fields.

For Title and Credit styles you may change the background image, colors, and define the position and
properties of text fields. To change the position of the text field select it on the Available fields list. The
field will be displayed as a light blue rectangle on the preview area. Use mouse to change the position. You
may also change the font, color, and alignment of the text fields.

Song style does not have a text field, but has lyrics field. You may define the properties of the lyrics using
Lyrics properties button.

 Note: The next paragraph applies to Pro version only.
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When using background image for text style you need to remember that lyrics cannot overlap with any
part of graphics. Also please make sure that the background color selected in Background color exactly
matches the lyrics area color. If this is not the case the lyrics will not be displayed properly.

Note: We recommend that you prepare your images so they are of 288x192 resolution and have no
more than 14 colors for title and credits, and 8 colors for lyrics background.

Import lyrics from CD+G file

One of the most exciting features of Karaoke CD+G Creator is an ability to import existing CD+G songs.
This allows to re-edit commercial editions of karaoke songs with endless possibilities -- use this to change
font and images, fix broken characters, change lyrics or create parodies. Karaoke CD+G Creator imports
both lyrics and synchronization, so the most cumbersome part of the song creation is already done,
leaving you all the fun.

To import CD+G song select Import CD+G File command from File menu or click Import CD+G File
button on the toolbar.

First you need to select file containing CD+G songs. Two file formats are supported -- CDG BIN file. If you
use CDG file, Karaoke CD+G Creator will automatically look for MP3 file of the same name and use it as a
soundtrack.

If Insert 'Clear Screen' events automatically is checked, Karaoke CD+G Creator will detect when
entire screen is erased in CD+G song and will insert 'Clear Screen' events at the same places in the
imported song. This help to maintain the text flow for page-by-page songs (SoundChoice songs give very
good results with this option enabled).

Import process takes a while (up to half a minute on a slower computer). Once it is completed you will see
the imported lyrics in the lyrics editor. Please check for spelling mistakes, as some of the characters may
be recognized incorrectly.

NOTE:
1. Not every song can be imported. Duets are not supported, also songs using scrolling will not
import.
2. Optical character recognition (OCR) is not perfect and may sometimes make an error. Please
check the lyrics for spelling mistakes.

Searching for MIDI karaoke on the web
Internet is full of MIDI karaoke files and Karaoke CD+G Creator provides a simple tool to help you find
them.

To start MIDI karaoke web search select Search the web for MIDI Karaoke command from File menu.
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To start the search you need to provide artist name and the title of the song. Note that the song title does
not have to be complete -- you may enter just first couple of words.

Search engine combo allows you to change the place that you will use to search for files. You may try
changing search engine if you are not getting the results you need.

Clicking on OK button will open the search in your web browser. Once you find the file save it to your hard
disc -- you may use it as a source to create CD+G song with Import MIDI Karaoke Wizard.

Disclaimer: Doblon does not provide MIDI karaoke files. They are provided by various websites that are
not affiliated with us.

Batch file create

Batch file create command from Create menu allows to write multiple CDG files in one session.

Use Add button to add PK2 files to the Input files list. Overwrite existing files without prompting will
disable warning messages that might stop the batch process.

Clicking OK will start processing. Please note that it may take a substantial amount of time if you add
many files to the list.

Batch MIDI import
Sometimes it is necessary to convert several MIDI Karaoke songs into CDGs. This process cannot be
fully automaticated, however Karaoke CD+G Creator gives you the possibility to convert a batch of KAR
songs without any user intervention. These songs can be opened and edited later to make sure they play
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correctly. Batch convertion saves time -- you do not have to select the songs and wait till they are
recorded as WAV files, instead you choose the songs and let Karaoke CD+G Creator convert them all in a
single process.

Important: Make sure that your MIDIs are converted correctly using Import MIDI Karaoke Wizard before
using this feature.

To convert a batch of KAR songs select Batch MIDI Karaoke Convert command from File menu.
Batch KAR Convertion dialog box will appear.

Add the files to convert using Add button. Note that you may add several files at once.

If you would like to remove any of the files, use Remove button.

Output directory points to the directory that will contain all WAV, PK2 and CDG/BIN files created during
the convertion.

If you do not want to be warned that files are getting overwritten, check Overwrite existing files without
prompting.

Checking Create .PK2 files option makes sure that every song is saved in .PK2 document. This option
makes possible to open and edit converted files afterwards.

Selecting Don't show error messages ensures uninterrupted processing, but may result in bad results if
some of MIDI files contain errors.

Output type defines if the output CDG song is saved into CDG or BIN file. For more information about
CDG and BIN files please see Writing CD+G files.

All CDG tracks are created using the current settings. You may modify it using CD+G Settings command
from Create menu.
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Advanced lyrics import

 Note: This feature is available in Pro version only.

Import lyrics with timing command from Toolbox menu allows to import the lyrics stored in a text file
along with the synchronization information.

The sample text file might look like this:

00:16.540 00:16.840 On 
00:16.842 00:17.100 a
00:17.102 00:17.360 dark
00:17.362 00:17.660 desert
00:17.666 00:17.800 highway\n
00:19.010 00:19.300 Cool
00:19.429 00:19.521 wind

It contains the start and the end time of a word. The end of the line is marked by \n symbol.

After the import is complete you may review the results by playing the file or inspecting time labels in the
soundtrack panel.

Lyrics file

Select the text file containing the lyrics.

File preview

Here you can see the contents of the selected file.

Time format

Choose the appropriate time format. Following formats can be used:

MM:SS.TTT minute:second.millisecond 
milliseconds milliseconds only
SS.TTT second.millisecond 

 File format
Select the format of the file. Following settings are available:
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Begin time only File contains only the start time of the word
Begin and end times File contains both the start and the end time of the word

Separator

Choose the separator between start time, end time, and text. The defaults are any space or tab
characters.

Max word length

If no end time for the word is given, PowerKaraoke assumes that the ending time is the beginning time of
the next word, but word duration cannot be longer than value specified by this option.

New line

Enter the text string that is used to mark a new line of text. By default it is '\n'.

Exporting lyrics

You may export lyrics from Karaoke CD+G Creator lyrics editor to the text file. To do this select Export
lyrics command from Toolbox menu.

Lyrics can be exported as a plain text (Lyrics only mode), they can contain starting time for the words
(Lyrics and starting time mode), or both starting and ending time (Lyrics and full time mode).

To write to Unicode text file make sure to select Use Unicode checkbox.
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Adjusting program settings

To adjust Karaoke CD+G Creator settings select Preferences from File menu.

General settings

Synchronization response delay

For an average person it takes approximately 150 milliseconds to react to a sound stimulus. To
compensate for this ‘response delay’ synchronization labels placed with space bar during synchronization
process are placed in a 150 ms time shift.

Synchronization preview accuracy

This setting determines how often the lyrics highlighting is refreshed during playback.

Animate shortcut bar

This option allows to disable animation in the shortcut bar. You need to restart Karaoke CD+G Creator for
the change to take effect.

Check for updates on exit

Karaoke CD+G Creator can prompt to check if updates are available -- you may disable this feature here.
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Lyrics Editor

 Note: This option is available in Pro version only.

Here you can set font and codepage used by the lyrics editor, and also enable right-to-left text flow. It can
be useful with Far Eastern (Chinese, Japanese, Korean) or right-to-left languages (Arabic, Hebrew, Farsi)
languages.

Color scheme button opens Lyrics editor colors window where you can edit colors used in lyrics
editor. You may use one of the predefined schemes or define and save your own.

 Note: This option is available in Pro version only.

Automatic countdowns

Automatic countdowns command from Edit menu allows to insert countdown event after every
instrumental break of the specified length.

Minimal break duration is a number of seconds of instrumental break after which countdown event will
be inserted.

Countdown settings allows to define settings for countdown events that will be inserted.
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Automatic Clear Screen insertion

Insert 'Clear Screen' at optimal positions command from Edit menu allows to insert Clear Screen
events automatically. Karaoke CD+G Creator analyzes the flow of the text and inserts events in such way,
that pages are changed during the longest breaks between words. This ensures that there is enough time
to display lyrics of the new page.

This command works for songs with two or more lines per page.

BIN/CDG converting functions

BIN to CDG+WAV  / CDG to BIN

To convert between various formats of karaoke files we recommend Power CD+G Burner 2. BIN to
CDG+WAV and vice versa converting can be done in trial version of the software without the need of
purchasing it.

Text Snippets

Often you may want to insert the same elements of the song multiple times into different songs. It may be
your custom title page, instrumental break or a way you like to format song's chorus. You may use Text
snippets to automate such tasks.

Text snippet is a part of a song (lyrics and events) that can be reused. You may define as many text
snippets as you like, you can also move them between computers.

To define a text snippet:

1. Select the text you would like to save as a snippet

2. Choose Text snippets from Edit window or right-click the selected text, choose Insert text snippet
from a drop-down menu and then choose Edit snippets from a submenu

http://www.powerkaraoke.com/src/prod_powercdgburner.php
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3. Text Snippets window will open. You will see the text you have selected in the Preview field. Your
snippet will be auto-named (you may change the name of the snippet by typing the new name in the
name field and then clicking Rename button)
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4. You may switch between snippets by selecting them from the drop-down list. You may also remove
currently selected snipped using Remove button

5. If you would like to insert a snippet using keyboard, you may define the hotkey for it. To do this use
Assing hot key button. You may use combination of alphanumeric keys with SHIFT, ALT and CTRL.

6. Selecting Close will save your snippet collection. Cancel will abandon the changes.

To insert a text snippet:

Position the cursor in the place you would like to insert the snippet and select Text snippets from Edit
menu, choose the snippet to insert and click Insert

or

Right-click with your mouse and choose the snippet from Insert text snippet submenu

or

Use the hotkey defined for the snippet

To copy snippets to another computer:

Choose Export from Tools menu in Text snippets window. You will be able to choose a location of the
file. All snippets will be saved. Move this file to a destination computer and choose Import there. You will
be presented an option of replacing the snippets or appending them (with renaming if necessary).

File
Edit
View
Play
Synchronize
Create
Toolbox
Help

File

New Song Wizard PowerWizard will help you to create your first CD+G karaoke song with Karaoke
CD+G Creator

New Allows to start work on a new song
Open Opens previously saved PK2 document
Save Saves current song to PK2 file
Save As Saves current song to PK2 file under a new name
Save As PKD File Allows to save the file in PKD format compatible with Power Video Karaoke

Import MIDI
Karaoke Wizard

Import MIDI Karaoke Wizard will assist you in process of converting MIDI karaoke to
CD+G

Batch MIDI
Karaoke Convert

Convert a batch of KAR songs at once

Search the web for
MIDI Karaoke

Internet is full of MIDI karaoke files and Karaoke CD+G Creator provides a simple tool
to help you find them

Load Soundtrack Loads the soundtrack for the song
Import lyrics from a
text file

Loads a content of a text file into the lyrics editor



74 Chapter 5 Command reference

5Command reference

Import lyrics from
MIDI Karaoke file

MIDI Karaoke files contain lyrics already synchronized with music. Use this command
to import them.

Search the web for
lyrics

Lyrics for most of the songs can be found on the internet. Karaoke CD+G Creator
contains a helper tool that will run the search for lyrics in your web browser.

Preferences Allows to adjust various Karaoke CD+G Creator settings

Edit

Undo Reverts last edit
Redo Redos the previously undone action
Insert CD+G Event Allows to insert CD+G event
Remove All Events Removes all CD+G events from the song
Shift labels Allows to move all of synchronization labels in the song 
Paste lyrics Use this command to paste lyrics from the clipboard into the lyrics editor

 Duet Wizard Duet Wizard allows to assign portions of the lyrics to each of the singers

Automatic countdowns Allows to insert countdown events after every long instrumental part
Insert 'Clear Screen' at
optimal positions

Analyzes the song and inserts Clear Screen events in such way that page
flow is optimal

Convert lyrics Converts the lyrics in the lyrics editor to the UPPERCASE, lowercase, Title
Case, and Sentence case

View

Main toolbar Shows and hides the main toolbar
Status bar Shows and hides the status bar
Shortcut bar Shows and hides the shortcut bar
CD+G Preview Shows and hides CD+G Preview in the lyrics editor panel
Soundtrack
information

Shows and hides the soundtrack information in the soundtrack panel

Reset toolbars Reverts the original toolbar placement
Small icons Uses small icons on the toolbars

Play

Start Ctrl+1 Start the playback from current cursor position
Pause Ctrl+2 Pauses the playback and resumes it
Stop Ctrl+3 Stops the playback. Cursor stays at the last played position.
Rewind Ctrl+4 Moves the playback position 10 seconds backwards
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Forward Ctrl+5 Moves the playback position 10 seconds forward
Playback speed Allows to change the playback speed
Play from start Ctrl+6 Moves the cursor to the start of the file and starts the playback
Play current word Ctrl+7 Plays the current word (starts 1 second before and ends 1 second

after)
Play current word
(loop)

Ctrl+8 Plays the current word in loop

Synchronize

Synchronize entire
song

Synchronizes the song from start

Continue
synchronizing

Continues the synchronization from the last synchronized word

Synchronize from
cursor

Synchronizes from the current cursor position

Synchronize
current line

Re-synchronizes the current line

Adjust word
synchronization

Allows to adjust the synchronization for the current line

Highlight lyrics
during playback

Displays word highlighting during playback

 Enable full
duet mode

Allows to enter full duet mode

Create

Create CD+G File Writes CD+G file to the disc
CD+G Settings Allows to adjust CD+G settings

Apply style Allows to apply style to the song

Run Power CD+G
Player

Plays recently created CDG file

Batch file create Allows to write multiple CDG files in one session

Toolbox

Vocal Remover Runs Power Vocal Remover

 Import lyrics
with timing

Allows to import the lyrics stored in a text file along with the synchronization
information

Export lyrics Export lyrics from Karaoke CD+G Creator lyrics editor to the text file

Help

Help topics Displays the online help
Quick Start Displays the tutorial
Tip of the day Displays the dialog box with simple tips on using Karaoke CD+G Creator

Start evaluation
period

Allows to start 14-day evaluation period.Requires internet connection.

Unlock Allows to unlock the full version of Karaoke CD+G Creator with the unlock code
purchased at PowerKaraoke website
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About Karaoke
CD+G Creator

Displays program information

Karaoke CD+G Creator comes on two versions - regular (Karaoke CD+G Creator) and Pro (Karaoke
CD+G Creator Pro).

Pro version contains some additional features that make it ideal choice for karaoke professionals.

Karaoke CD+G Creator version comparison chart

Feature Karaoke CD+G
Creator

Karaoke CD+G
Creator Pro

General

Create CD+G Songs from scratch X X

Use PowerWizard to create songs X X

Load and save songs X X

Lyrics

Edit lyrics X X

Right-to-left and Far East language support X

Import lyrics from text file or MIDI karaoke X X

Search for lyrics on the internet X X

Advanced lyrics import X

Lyrics export X X

Soundtrack

Use MP3 of WAV files as soundtracks X X

Remove vocals with Power Vocal Remover X X

View soundtrack graph X X

Synchronization

Synchronize lyrics to the music X X

Decrease playback speed for better synchronization X X

Adjust synchronization with labels and buttons X X

Images

Display title image X X

Display credits image X X

Use image display and erase effects X X

Display image in the middle of the song X X

Display image together with lyrics X

Display images anywhere on the lyrics screen X

Synchronize image display time X

Use title and credit styles X X

Use song styles with images X

CD+G options

Create BIN files to record to CD+G disc X X

Create CDG files to play on your computer X X

Change font, colors, alignment, and number of lines per screen X X

Use page-by-page lyrics display X X
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Use overwrite lyrics display X

Use scrolled lyrics display X

Squeeze text to keep lines from breaking X X

Use setting presets X X

Fast settings preview X X

Duets

Use simple color changes for duets X X

Split screen duet mode X

Concurrent singer highlighting X

Advanced duet synchronization X

Duet Wizard X

Other

Automatic countdowns X X

MIDI web search X X

Batch processing X

Power CD+G Player X X

BIN/CDG converter X X

How do I unlock Karaoke CD+G Creator? 

To unlock Karaoke CD+G Creator you need to purchase the unlock code from PowerKaraoke website.
The unlock code will be delivered via email. Once you have it select Unlock command from Help menu.

You will have to provide your name, email address used to purchase the unlock code, and the unlock code
itself. If the unlock code is accepted all limitations will be removed and you will see your name in the About
dialog box. 

How do I evaluate Karaoke CD+G Creator?

Karaoke CD+G Creator provides the 14-day evaluation mode, during which you will be able to use all
program functions. To use it select Start evaluation period command from Help menu. Starting
evaluation period requires internet connection.

What are the limitation of the trial version

Unregistered version of Karaoke CD+G Creator has the following limitations:
· You are not able to save PK2 files (you may create BIN files though)

· Vocal remove will remove vocals from first minute of the song

· After first two pages of the lyrics your words will be replaced with Karaoke CD+G Creator

http://www.powerkaraoke.com/src/buy_main.php
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